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Preâmbulo/Prefácio  

 

 

O Laboratório de Análise de Movimento Humano do Centro de Estudos de Movimento e Atividade 

Humana constitui uma unidade de investigação e desenvolvimento (I&D) integrada no Centro de 

Investigação em Reabilitação (CEMAH-CIR). Localizada na Escola Superior de Saúde do Instituto 

Politécnico do Porto, esta unidade dedica-se ao estudo tridimensional do movimento humano ao longo do 

ciclo de vida, com os seguintes objetivos: 1) auxiliar o profissional de saúde no processo de tomada de 

decisão; 2) criar uma base de conhecimento que pode ser usada para estabelecer a ligação entre disfunção, 

os mecanismos de base e a intervenção no sentido da personalização dos cuidados de saúde, e 3) identificar 

fatores determinantes para otimização do movimento humano. 

Para dar resposta aos objetivos enunciados, o Laboratório de Análise de Movimento Humano do CEMAH-

CIR está equipado com um sistema integrado constituído por: 

• doze câmaras optoelectrónicas, oito do modelo Oqus 500, quatro do modelo Miqus M3 e duas 

câmaras de vídeo Miqus da Qualisys Track Manager (Qualisys AB®, Suécia) 

• três plataformas de força, duas do modelo FP4060-08 e uma do modelo FP4060-10 (Bertec®, 

Columbus, OH, Estados Unidos da América); 

• um sistema de aquisição de sinal eletromiográfico de superfície composto por 16 sensores wireless 

(Trigno Avanti).  

O processamento e análise dos dados recolhidos por este sistema integrado pode ser desenvolvido nos 

softwares Qualisys Track Manager® para aquisição e pré-processamento de dados, Visual3D Professional™ 

(Has-Motion, Inc., Kingston, Ontário, Canada) para processamento de dados e EMGworks Acquisition and 

Analysis (Delsys Inc., Natick, MA, USA) para avaliação da qualidade do sinal eletromiográfico. 

Com o objetivo de auxiliar o investigador a familiarizar-se com as ferramentas anteriormente referidas, este 

manual descreve os procedimentos necessários para o planeamento, execução da recolha e pré-

processamento de dados utilizando o sistema Qualisys Track System, bem como para a avaliação da 

qualidade do sinal eletromiográfico através do software EMGworks. O processamento de dados no Visual3D 

Professional™ não será abordado neste manual, dada a sua complexidade técnica. Este último software 

dedicado à criação e análise de modelos biomecânicos tridimensionais, deve ser utilizado com apoio de 

investigadores experientes do laboratório.  

Tendo em consideração o exposto, este manual encontra-se organizado em dois capítulos principais. O 

primeiro capítulo intitulado “Procedimentos de Recolha de Dados Biomecânicos no Laboratório de Análise de Movimento 

Humano do CEMAH-CIR” apresenta a definição do âmbito do estudo e os critérios para a seleção das 

variáveis biomecânicas a analisar. São descritos os procedimentos para a escolha do conjunto de marcadores 

refletores, criação de um novo projeto, configuração dos respetivos settings, importação de configurações de 

projetos pré-definidos e utilização do mesmo projeto em diferentes computadores. 

O segundo capítulo, “Procedimentos de Análise de Dados Biomecânicos no Laboratório de Análise de Movimento 

Humano do CEMAH-CIR”, aborda os passos necessários para a identificação das trajetórias dos marcadores, 

assim como a sua edição e correção de falhas. São também descritos os procedimentos de edição de spikes, 

suavização dos sinais (smoothing) e adição de trajetórias virtuais. Por fim, este capítulo inclui a criação do 

modelo AIM (Automatic Identification of Markers), bem como os procedimentos iniciais de análise de dados, 

incluindo a marcação de eventos.  



 

Resumo 

 

Este manual foi elaborado para auxiliar o investigador a familiarizar-se com o sistema de análise de 

movimento disponível no Laboratório de Análise de Movimento Humano do Centro de Estudos de 

Movimento e Atividade Humana do Centro de Investigação em Reabilitação (CEMAH-CIR). O CEMAH-

CIR dispõe de um sistema de análise composto por doze câmaras optoelectrónicas (oito Oqus500 e quatro 

MiqusM3), duas câmaras de vídeo (Miqus) da Qualisys Track Manager (Qualisys AB®, Suécia), três 

plataformas de força (FP4060-08/10, Bertec®, Columbus, Ohio, EUA) e um sistema de eletromiografia de 

superfície Trigno Avanti (Delsys Inc., Natick, MA, USA).  

Para a elaboração deste manual foram consideradas as recomendações do fabricante, bem como a 

experiência do grupo de investigação do CEMAH-CIR cuja produção científica pode ser consultada no 

website do CIR (https://cir.ess.ipp.pt/index.php/publications/). 

 

Palavras-chave: Biomecânica, Movimento, Cinemática, Cinética, Eletromiografia 

 

 

  



 

Abstract 

 

This manual was developed to assist researchers in becoming familiar with the motion capture system 

available at the Human Movement Analysis Laboratory of the Center for Studies in Human Movement and 

Activity, integrated into the Rehabilitation Research Center (CEMAH-CIR). CEMAH-CIR is equipped with 

a motion analysis system composed of twelve optoelectronic cameras (eight Oqus500 and four MiqusM3), 

two video cameras (Miqus) from Qualisys Track Manager (Qualisys AB®, Sweden), three force platforms 

(FP4060-08/10, Bertec®, Columbus, Ohio, USA), and a Trigno Avanti surface electromyography system 

(Delsys Inc., Natick, MA, USA). 

The preparation of this manual was based on the manufacturers’ recommendations, as well as the experience 

of the CEMAH-CIR research team, whose scientific output can be accessed through the CIR website 

(https://cir.ess.ipp.pt/index.php/publications/). 
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I. Procedimentos de recolha de dados biomecânicos no 
Laboratório de Análise de Movimento Humano do 

CEMAH-CIR 

1.1 Interface gráfica e funcionalidades do sistema Qualisys Track Manager 

Ao iniciar o Qualisys Track Manager (QTM) é apresentada a janela principal (Figura 1), onde se destaca a 

barra de ferramentas com ícones de acesso rápido. O ícone Start Capture (círculo vermelho) abre uma janela, 

no qual se definem a duração da recolha, a pasta de destino e as opções de nomeação automática dos 

ficheiros. O ícone quadrado preto Stop termina uma recolha em curso (aparecendo no lugar do ícone Start 

Capture). 

Na margem esquerda encontra-se uma barra vertical que permite alternar entre as vistas 2D e 3D, bem 

como aceder a ferramentas específicas, como o Quick Identification (ID) (Figura 2) (ver secção2.1.1 

Identificação de trajetórias 

 

A janela de visualização 2D apresenta, em tempo real ou posteriormente, a imagem de cada câmara. Na 

barra lateral da margem direita encontram-se parâmetros fundamentais para ajustar cada câmara antes da 

calibração ou da captura de movimento. É possível alternar entre três modos de câmara (Figura 3): 

• Marker: modo padrão de identificação e visualização de marcadores; 

• Marker Intensity: imagem 2D codificada por cores, em que locais a amarelo/vermelho são 

considerados marcadores. Esta definição pode ser modificada através do ajuste do Exposure 

& Flash Time e do Marker Threshold; 

Figura 1 - Barra de ferramentas: Start Capture 

Figura 2 - Barra de ferramentas vertical 
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• Video: gravação de vídeo sincronizado com os dados 3D. 

Para além disto, na barra lateral é possível definir a frequência de aquisição das câmaras, a resolução e 

proporção do vídeo, bem como definições relacionadas com a exposição das câmaras. 

A janela de visualização 3D exibe a reconstrução dos marcadores refletores e do vetor resultante das 

plataformas de força. Na barra superior existem três painéis de trajetórias acessíveis a partir dos ícones 

presentes na Figura 4: 

• Labeled trajectories: trajetórias identificadas; 

• Unidentified trajectories: trajetórias sem identificação; 

• Discarded trajectories: trajetórias excluídas. 

Figura 3 - Barra lateral: Camera settings 

Figura 4 - Barra de ferramentas: janelas das trajetórias 
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Na base das janelas de visualização existe a barra temporal (Figura 5). O cursor triangular representa o frame 

atual da recolha e é possível percorrer o ficheiro, mantendo premido o botão esquerdo do rato sobre o 

cursor. Os cursores laterais permitem definir um intervalo de interesse para análise ou exportação de dados. 

1.2 Definição do protocolo de recolha cinemática 

Na investigação, a recolha de dados deve ser realizada de forma criteriosa e exata. Assim sendo, durante a 

realização de uma recolha de dados cinemáticos com recurso a um sistema optoelectrónico, é essencial que 

seja aplicado um protocolo de recolha de dados biomecânicos. Um protocolo de recolha de dados 

biomecânicos é um guião que auxilia o investigador a uniformizar os procedimentos de preparação e recolha 

de dados cinemáticos, permitindo reduzir os vieses entre medições. 

1.2.1 Definição de âmbito e variáveis biomecânicas 

Em primeira instância, para definir um protocolo de recolha de dados biomecânicos passível de ser 

implementado no CEMAH-CIR, é necessário a definição prévia da área de estudo e a população que se 

pretende avaliar. Salienta-se que, no CEMAH-CIR, existem linhas de investigação pré-definidas com um 

background e experiência relevantes na investigação das respetivas áreas de estudo. Tal permite que o 

investigador com menor experiência com este tipo de recursos possa discutir e aconselhar-se com os 

respetivos coordenadores de cada linha de investigação sobre o protocolo a implementar. 

Posteriormente, devem ser definidos a metodologia (incluindo a preparação do participante, o protocolo de 

avaliação e o número de marcadores), as variáveis que se pretendem obter como resultado da recolha, bem 

como o equipamento de medição associado. Para obter esse conhecimento recomenda-se a consulta de 

bibliografia de qualidade, isto é, presente em revistas indexadas, e o estudo da metodologia utilizada em 

projetos previamente realizados pela instituição. A informação referente aos estudos realizados e aos 

equipamentos de avaliação biomecânica atualmente disponíveis, pode ser consultada respetivamente nas 

páginas Publicações e Equipamentos do site do CIR (https://cir.ess.ipp.pt/). 

Após a definição do protocolo de recolha de dados, incluindo a preparação do laboratório, do participante, 

recolha e análise dos dados, recomenda-se o agendamento de uma reunião com um dos responsáveis pela 

utilização do equipamento de forma a ser avaliada a viabilidade do protocolo proposto, bem como, serem 

concedidas as orientações e alertas necessários para a sua concretização com sucesso, utilizando os espaços 

e equipamentos da instituição. 

O teste de procedimentos deve ser realizado antes de se iniciar a fase de recolhas (fase esta que estará 

dependente da aprovação do estudo a realizar por uma comissão de ética). Este teste inclui a realização de 

todos os procedimentos de uma recolha formal. É recomendado que seja testado em primeiro lugar o 

protocolo de recolha definido, a fim de avaliar a exequibilidade do mesmo, bem como, ajustar os 

procedimentos necessários para a sua aplicação. É essencial também processar e analisar os dados obtidos 

de forma a conseguir identificar a necessidade de alterar algum parâmetro ou procedimento. 

Figura 5 - Barra temporal 

http://cir.ess.ipp.pt/index.php/publications/
http://cir.ess.ipp.pt/index.php/equipments-2/
http://cir.ess.ipp.pt/
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1.2.2 Seleção do setup de marcadores refletores 

O sistema optoelectrónico do Laboratório de Análise de Movimento do CEMAH-CIR, requer a utilização 

de marcadores refletores posicionados em referências anatómicas para representar os segmentos corporais. 

Para tal, deve ser tido em consideração o setup de marcadores refletores definido pelo laboratório de análise 

de movimento do CEMAH-CIR apresentado nas Figuras 6 e 7, bem como as recomendações para a 

identificação de referências anatómicas (Sint Jan., 2007). 

Se for necessário utilizar marcadores refletores em localizações anatómicas diferentes das referidas, o 

utilizador deve confirmar com um membro da equipa de investigação com experiência no uso do 

equipamento, se o novo setup permite obter os dados e as variáveis pretendidas (Caimmi et al., 2007; Donato 

et al., 2021; Fischer et al., 2020; Mesquita et al., 2019; Sousa et al., 2021; Sousa et al., 2020; Wang et al., 

2020). 

Embora seja possível extrair algumas variáveis cinemáticas a partir do software QTM, o software Visual3D™ 

(Has-Motion Inc., Kingston, Ontário, Canadá), constitui o software principal de análise biomecânica para a 

Figura 6 - Setup de marcadores do Laboratório de Análise de Movimento Humano do CIR para tronco e membro 

superior 

Figura 7 - Setup de marcadores do Laboratório de Análise de Movimento Humano do CIR para membro inferior 



 5 

medição de dados de movimento, sendo compatível com a grande maioria dos sistemas de captura de 

movimento tridimensional. Fornece os cálculos necessários para dados cinemáticos e cinéticos, incluindo 

técnicas matemáticas para a otimização do processamento de dados, dinâmica inversa, modelação 

biomecânica, entre outros. É um software independente de um hardware e de um conjunto de marcadores 

refletores pré-definido e tem a funcionalidade de criar um esqueleto tridimensional funcional, através do 

qual é possível extrair dados validados e consistentes com a recolha de movimento. Para mais informações, 

pode consultar o site da Has-Motion que contém uma diversa lista de tutoriais (Has-motion, 2024). 

1.3 Definição do projeto 

A utilização do QTM disponível no Laboratório de Análise de Movimento do CEMAH-CIR requer a 

criação de um projeto (project). O project consiste num conjunto de definições necessárias para a recolha de 

dados, organizada numa estrutura de pastas e ficheiros criados automaticamente pelo QTM para a captura 

dos dados a serem estudados. Este deve conter todos os ficheiros e informação necessária sobre o 

processamento dos mesmos, como a frequência de amostragem, os equipamentos a serem utilizados e as 

suas configurações (Qualisys, 2011). Recomendações importantes: 

• Utilizar um project para cada estudo de investigação do laboratório e por cada setup de marcadores 

refletores, devendo as avaliações dos diferentes indivíduos constar em subpastas na pasta Data do 

projeto, para serem facilmente visualizadas na janela Project View; 

• Realizar de forma recorrente um backup dos settings, uma vez que as alterações são gravadas 

automaticamente. Deste modo, em caso de erro, garante-se o acesso aos settings corretos; 

• É possível facilitar o acesso ao project, através da ativação de um pin único para aceder ao setup; 

• A criação de um Project Preset, permite a elaboração de vários projetos com base nos mesmos settings; 

• Nos casos em que o projeto é utilizado em simultâneo com outro sistema de câmaras (p.g.: projetos 

que realizem recolhas em laboratórios diferentes) é recomendado que o setup esteja presente em 

cada um dos computadores dos respetivos laboratórios e que apenas se copiem os ficheiros Data e 

AIM, para garantir que não existe o risco de se perderem os settings e para facilitar o manuseamento 

dos dados. O utilizador, ao salvaguardar os dados recolhidos, deve copiar todo o “Project”, incluindo 

todas as pastas, subpastas e settings. Isto garante que mesmo noutro computador é possível usar o 

QTM para processar dados; 

• Quando se abre um project, o QTM utiliza a última calibração feita pelo computador de recolha, 

podendo ser carregada a calibração de um project diferente. Por esta razão, deve verificar-se sempre 

a data e hora dos ficheiros das calibrações na pasta Calibrations do project, para garantir que apenas 

constam as calibrações realizadas para o estudo. No entanto, deve ter-se em conta que ao abrir 

ficheiros já recolhidos, eles mantêm a calibração com que foram realizados, sendo esta distinta da 

calibração do project. Por esta razão, ao abrir um project para uma recolha, é recomendado que se 

efetue uma nova calibração. 

Nota: o QTM copia o último ficheiro de calibração feito com o mesmo sistema para a pasta do project, mas 

não a aplica aos dados já recolhidos. 
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1.3.1 Criação de um projeto 

É possível criar um projeto de duas formas distintas. A primeira decorre aquando da iniciação do QTM e 

surge a janela inicial para definir o projeto. Deve ser selecionada a opção Create Project, havendo a 

possibilidade de importar os settings de outro project, ou definir manualmente. A segunda forma, decorre 

quando o QTM já se encontra aberto e é selecionado na barra principal File > New Project. Em qualquer uma 

das formas, surgirá a janela New Project - Settings (Figura 8) na qual se deve preencher a seguinte informação 

(Qualisys, 2011): 

i. Escrever o nome a atribuir ao projeto na barra Project Name. Este será também o nome da pasta 

associada ao project, automaticamente criada. Se necessário, pode alterar-se o nome do project 

posteriormente, através da opção Rename Project no menu File; 

ii. Selecionar o local onde o projeto deverá ser guardado. Por defeito, o QTM arquiva os ficheiros na 

pasta Documents do computador. Para alterar o diretório, deve selecionar Browse e escolher a nova 

localização. É possível alterar o caminho por defeito do QTM para os projects seguintes, através do 

acesso na barra principal, selecionando Tools > Project Options > Folder Options; 

iii. Definir a fonte dos settings que deverão estar associados na secção Base the new project on. Desta forma, 

deve-se selecionar Settings imported from another project para escolher settings de outro projeto. É possível 

também selecionar settings criados por defeito pelo QTM através da opção Default Settings, ou ainda 

a opção The current project para usar os settings do project aberto no momento. Os settings podem ser 

visualizados e alterados na barra principal, selecionando Tools > Project Options. Ao selecionar 

qualquer opção que não o The Current Project, os settings atuais no Project Options irão ser perdidos.  

iv. Se já existirem módulos de análise PAF (Project Automation Framework) instalados no computador, e 

se o objetivo for criar um projeto com automação, deve ser selecionada a opção Use PAF module, 

escolhendo o módulo existente (Excel, MATLAB, Python™ e Visual3D™). 

  

Figura 8 - Janela Novo Projeto 
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1.3.2 Criação de settings de um projeto 

Como referido anteriormente, é necessário definir para cada projeto os settings necessários para aplicar o 

protocolo de avaliação. Relembra-se que este procedimento deverá ser realizado por um responsável do 

laboratório ou com a supervisão deste. Pede-se que não se inicie nenhuma recolha sem a devida validação 

dos settings, uma vez que caso algum parâmetro esteja incorreto, todos os dados poderão tornar-se inválidos. 

Para definir os settings do projeto, deverá ser selecionada na barra principal a opção Tools e de seguida Project 

Options ou diretamente a partir da seleção do ícone  na barra secundária (Figura 9). Posteriormente irá 

surgir a janela Project Options onde é possível visualizar as diferentes secções e subsecções para a definição 

dos settings do projeto. 

Na secção Input Devices, devem ser selecionadas as caixas de verificação dos equipamentos que irão ser 

utilizados para o protocolo de recolha. Os círculos existentes junto a cada um dos equipamentos permitem 

saber o estado de ativação de cada um. Podem apresentar-se verdes se os dispositivos estiverem conectados, 

amarelos se os dispositivos forem desconhecidos, e vermelhos se os dispositivos não estiverem conectados 

(Figura 9). No caso da placa analógica (analog board), os settings estão associados ao número de série da placa, 

mesmo que o dispositivo esteja desconectado ou não esteja ativo no Instacal.1 

É possível adicionar um dispositivo, selecionando Add Device, nos casos em que sejam utilizados outros 

equipamentos como a Delsys, ou remover dispositivos em Remove Device, caso não sejam conectados. 

Também é possível realizar Refresh para atualizar o estado dos dispositivos. É importante saber que esta 

 
1 Software que permite instalar, configurar, testar e calibrar dispositivos de aquisição de dados (DAQ). É utilizado para 

reconhecer e preparar automaticamente o hardware, como plataformas de força, antes da sua utilização em softwares de 

análise de movimento. 

Figura 9 - Project Options: Input Devices 
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última opção funciona com todos os dispositivos, à exceção das placas analógicas, quando estas estão 

instaladas ou alteradas no Instacal, devendo-se, para isso, reiniciar o QTM. 

 

Camera System 

Dentro da secção Input Devices é possível selecionar a subsecção Camera System para definir o sistema de 

câmaras a ser utilizado, a frequência de aquisição de dados, a frequência em tempo real e ainda visualizar o 

estado geral de cada setting associado (Figura 10). 

Nesta subsecção é possível:  

1. Selecionar Locate Sytem para localizar o sistema de câmaras conectadas com o QTM; 

2. Selecionar a frequência de aquisição de todas as câmaras para as recolhas de movimento; 

3. Selecionar a opção Reduced real time frequency para permitir uma melhor pré-visualização dos dados. 

Por esta razão, a frequência selecionada deve ser inferior à selecionada no Marker capture frequency; 

4. Se os settings estiverem com valores dentro da amplitude normal, antes de cada item, deverá aparecer 

um círculo verde. Caso estes estejam diferentes dos valores normais, irá surgir um triângulo amarelo 

com um ponto de exclamação. Se os settings não estiverem configurados de forma adequada, irá 

surgir um triângulo vermelho com um ponto de exclamação. Se uma das duas últimas opções 

acontecer, deve-se clicar com o botão direito do rato sobre o item e selecionar Change para ir 

diretamente à página do item ou Reset to default(s) para que o item assuma os valores dos settings por 

defeito. 

  

Figura 10 - Janela de configuração dos settings das câmaras 
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Analog Board 

Na secção Input Devices é possível selecionar a subsecção Analog Board para definir a frequência de 

aquisição, os settings da placa e os diferentes canais (Figura 11). Nesta secção é possível:  

1. Selecionar a frequência de aquisição a ser utilizada na recolha. No caso de avaliações exclusivamente 

cinemáticas, a taxa de aquisição é de 100 amostras por segundo, no caso de serem utilizadas 

plataformas de força ou eletromiografia (EMG), a taxa de aquisição aumenta para 1000 amostras 

por segundo; 

2. Selecionar a opção Simultaneous start para que a placa analógica inicie quando o sistema de câmaras 

capturar o primeiro frame, o que significa que poderá haver uma pequena variação entre os dados 

das câmaras e da placa analógica; 

3. Na subseção seguinte, Board settings, pode ser selecionada Bipolar Range para permitir uma voltagem 

positiva e negativa e manter a voltagem de 10 Volts, apresentada por defeito; 

4. A subseção Force Plate Control, não é aplicável, uma vez que as plataformas de forças do CIR não 

são do tipo Kistler 5695 DAQ; 

5. Na subseção Channels é possível visualizar e ativar os canais, selecionando as caixas de verificação 

correspondente. Os canais analógicos devem ser selecionados de forma sucessiva. É possível ainda 

identificar os canais para facilitar o seu reconhecimento aquando da recolha, devendo-se clicar duas 

vezes sobre o nome para o renomear. No caso dos canais de EMG, se recolhido de forma analógica, 

na coluna Delay dos canais referentes à EMG, deve ser inserido, em cada um dos canais, o delay 

associado de 48 ms. Como esta é uma medida conhecida, inerente a um dos sistemas de medição, 

pode ser corrigido durante a análise de dados, iniciando-se a sua análise após o tempo do próprio 

delay. É importante notar que, embora seja possível integrar a recolha EMG de forma analógica, no 

Figura 11 - Janela para definição das opções do projeto para a placa analógica 
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Laboratório de Análise de Movimento do CEMAH-CIR a integração da EMG é concretizada de 

forma digital. 

Processing 

Na secção Processing é possível selecionar separadamente as ações que podem ser aplicadas nos dados 2D 

durante a recolha Real time actions, e após a recolha Capture actions (Figura 12). Para isso deve-se selecionar 

apenas as caixas de verificação que se pretende para o estudo: 

• Auto backup - Para o sistema realizar um backup automático; 

• Pre-Process 2D data - Para o sistema pré-processar os dados antes da recolha; 

• Track each frame in 3D - Para o sistema fazer o cálculo das posições dos marcadores em 3D; 

• Merge with twin slave - Para o sistema fundir os dados com os de um sistema semelhante; 

• Gap-fill the gaps - Para o sistema preencher automaticamente, até um limite pré-definido, as falhas de 

dados existentes; 

• Apply the current AIM Model - Para o QTM aplicar automaticamente o modelo de identificação 

automática de marcadores atual (ver secção “Criação do AIM (Automatic Identification of Markers) 

Model”); 

• Calculate 6DOF - Para o sistema permitir calcular os corpos rígidos, previamente definidos nos 

settings; 

• Calculate force data - Para o sistema calcular automaticamente os dados resultantes das plataformas 

de força. Isto é, a aplicação da matriz de calibração e a representação tridimensional do vetor de 

força correspondente; 

• Export to TSV, C3D format, MATLAB file e/ou AVI file - Para o sistema exportar automaticamente 

os ficheiros nos formatos TSV, C3D, MATLAB ou AVI. 
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Miscellanous 

Na secção Miscellanous é possível selecionar os settings da pasta do projeto, a abertura automática do projeto, 

a Startup, e a lista dos eventos, Events. 

Dentro da secção Miscellanous encontra-se a subsecção Folder Options que contém os settings para a localização 

dos diferentes ficheiros produzidos pelo QTM, que podem ser alterados (Figura 13). Assim, por defeito: 

• Os ficheiros com as calibrações são guardados na pasta Calibrations do projeto; 

• Os ficheiros com os modelos são guardados na pasta AIM Models do projeto; 

• As pastas dos projetos são guardas na pasta Documentos dos users; 

• Os ficheiros de vídeo temporariamente armazenados são guardados numa pasta Temp da aplicação, 

assim como os ficheiros de backup automáticos; 

• A pasta de linearização é guardada no Linearization na pasta de instalação do software QTM. 

Em relação aos ficheiros das calibrações e dos AIM models, uma vez que estão guardados dentro das pastas 

específicas dos projetos, caso seja pertinente alterar os diretórios, é necessário mudar de forma manual para 

cada projeto.  

Figura 12 - Janela para Project Options: Processing 
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Após a seleção dos settings da janela Project Options, deve ser selecionado OK para aplicar os novos settings na 

medição atual e fechar a janela, ou selecionar Apply para aplicar os settings sem fechar a janela. Pode ser ainda 

selecionada a opção Cancel para fechar a janela sem salvar os settings alterados ou pressionar o botão Help 

para obter ajuda do programa QTM. 

1.3.3 Importação de settings de projetos pré-definidos  

Estão disponíveis vários projetos-padrão, designados Preset, que possuem os settings adequados para os setups 

de recolhas mais frequentemente realizados no Laboratório de Análise de Movimento do CEMAH-CIR e 

que podem ser utilizados para a criação de novos projetos, nomeadamente: 

• Kinetics & Kinematics Preset – 13 câmaras (8 Oqus500, 4 MiqusM3 e 1 Miqus de vídeo) e 3 

plataformas de força com uma taxa de aquisição de 100 Hz e 1000 Hz, respetivamente; 

• Kinetics, Kinematics & Eletromiography Preset – 13 câmaras (8 Oqus500, 4 MiqusM3 e 1 Miquos 

de vídeo), 3 plataformas de força e 1 sistema de EMG com uma taxa de aquisição de 100 Hz, 1000 

Hz e 1000 Hz, respetivamente. 

Para utilizar um destes Presets, no momento da criação do projeto, é possível selecioná-lo diretamente a partir 

da lista disponível na secção Base the new project on, desde que tenha sido previamente guardado como Preset 

no computador em utilização. Por outro lado, se os settings não forem guardados como Preset, pode 

selecionar-se a opção Settings imported from another project para importar os settings de um projeto anterior. Em 

ambos os casos, os Presets e os settings são armazenados localmente, mas é necessário garantir que estão 

disponíveis no computador onde o projeto será criado. 

1.3.4 Uso do projeto em diferentes computadores 

O projeto pode ser transferido para análise noutros computadores, devendo conter sempre todos os settings 

e ficheiros necessários para o processamento. É assim aconselhado que toda a pasta do projeto seja 

transferida. 

1.4 Calibração do volume de captura tridimensional 

Figura 13 - Janela para Project Options: Folder Options 
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A calibração do volume de captura tridimensional tem em vista a redução do erro associado a uma recolha 

de movimento, o incremento da fiabilidade e veracidade dos dados recolhidos e a definição de um referencial 

global e a correspondente localização e orientação das câmaras, para o cálculo das coordenadas dos 

marcadores. 

Para a realização da calibração, será necessário o kit de calibração, constituído por (Figura 14): 

• Vareta de calibração metálica em formato de T, com 2 marcadores refletores nas extremidades 

opostas da vareta. A distância entre os marcadores é fixa e conhecida, tendo sido alvo de calibração 

de fábrica, o que permite a realização de calibrações fiáveis; 

• Referencial de calibração metálico articulado, em formato de L com 4 marcadores refletores e 3 

patilhas metálicas. 

Antes de iniciar a montagem do kit de calibração e colocação do referencial, deve-se abrir o programa QTM, 

selecionar Open Project e selecionar a pasta do projeto para abrir o projeto criado especificamente para o 

estudo. De seguida, deve ser selecionado na barra principal File > New ou pressionar o ícone com a folha 

em branco para abrir uma nova sessão. Posto isto, a calibração deve ser realizada da seguinte forma: 

i. Verificar se as câmaras estão todas ligadas (com o número da câmara a surgir no canto inferior 

esquerdo e o número de marcadores refletores a ser detetado no canto inferior direito) e 

corretamente posicionadas para a recolha de movimento; 

ii. Perceber se existem marcadores refletores que estão a aparecer nas câmaras através da análise em 

modo 2D da barra de ferramentas vertical e selecionando os modos de vídeo e marker intensity de 

cada câmara, para identificar as possíveis fontes refletoras de luz ou marcadores refletores que 

estejam à vista. No caso de não ser possível eliminar ou ocultar marcadores refletores indesejados, 

pode ser utilizada a opção Auto-Mask, que permite criar máscaras virtuais para ocultar o(s) 

marcador(es) referidos. Contudo, após a aplicação do Auto-Mask, é necessário verificar se existem 

máscaras sobre a zona de interesse da recolha. Este procedimento deve ser realizado antes da 

colocação do referencial, de forma a evitar que os marcadores do calibrador fiquem ocultos; 

iii. Colocar o referencial de calibração orientado como na Figura 14, encaixando as patilhas metálicas 

nas laterais da plataforma de forças, de modo a que os eixos do referencial coincidam com os eixos 

da plataforma. Após a colocação, deve verificar-se se o calibrador está nivelado, podendo ajustar-

se a sua altura através das rodas niveladoras presentes nas extremidades; 

Figura 14 - Imagem ilustrativa da vareta de calibração e do referencial de calibração  
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Nota: Todas as câmaras devem, neste momento, conseguir identificar os 4 marcadores presentes no 

referencial. 

iv. Confirmar se os settings do projeto adotado vão de encontro à colocação do referencial. Para isso, 

deve-se selecionar: Project options > tools > calibration > Confirmar a correspondência de 

características, nomeadamente o kit de calibração e o comprimento exato da vareta > OK (Figura 

15) (Atenção: Sem esta configuração a calibração estará incorreta); 

v. Após garantir todas as condições para realizar a calibração sem nenhuma interrupção, pode iniciar-

se a calibração do QTM, premindo o ícone da calibração, representado por uma vareta, na barra de 

ferramentas secundária; 

vi. Montar a vareta de calibração e definir um volume de calibração que contenha o espaço necessário 

para a realização dos diferentes tipos de movimentos da recolha e a variação das características 

antropométricas de todos os participantes esperados; 

vii. Definir o tempo de calibração, dependendo das dimensões do volume de calibração (quanto maior 

o volume maior o tempo necessário para a calibração). Outro fator condicionante do tempo de 

calibração é o Maximum number of frames used as calibration input (Figura 15). Se forem definidos 1000 

frames, uma vez que as câmaras apresentam uma frequência de 100 Hz, o tempo de calibração deverá 

ser de 10 segundos para que não exista a perda de frames utilizados para a construção do volume 

de calibração. Para além disso, pode ser adicionado um delay para permitir que o investigador 

consiga deslocar-se do computador até ao referencial antes antes do início da calibração. Pode ser 

selecionada a opção de som (Sound option) para que o sistema emita um som no início e fim da 

calibração em forma de aviso; 

Assim que começar a contagem do tempo de calibração, deve-se: 

Figura 15 - Janela para identificação da orientação do referencial no projeto 
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• Movimentar lentamente a vareta de calibração, alternando entre as diferentes direções de 

movimento (horizontal, vertical, obliqua, espiral em movimentos de varredura), dentro do volume 

de calibração a criar, de forma que as câmaras detetem os marcadores da vareta de calibração; 

• Movimentar ao longo de um eixo de 360 graus de rotação em torno do volume de calibração, isto 

é, em torno do referencial e das plataformas de força, de modo a impedir que ocorra um bloqueio 

na captação por parte das câmaras. Assegurar que são alcançadas todas as extremidades (superior, 

inferior e laterais) do volume de calibração. 

viii. Assim que a calibração terminar, surgirá a janela pop-up Calibration Results semelhante à apresentada 

na (Figura 16) com os seguintes parâmetros: 

• X (mm), Y (mm) e Z (mm): Corresponde à distância, em milímetros, entre a origem do referencial 

de coordenadas do sistema QTM e o centro ótico da câmara em cada um dos eixos X, Y e Z; 

• Points: Corresponde ao número de pontos usados no cálculo da distância anteriormente 

mencionada. O número razoável de pontos deverá permanecer acima dos 500, e deverá ser 

semelhante entre câmaras; 

• Avg. residual (mm): É a média residual entre as câmaras, devendo encontrar-se entre os 0.5 e os 

1.5 mm e ser o mais semelhante e reduzido entre câmaras (se a disposição das câmaras o permitir); 

• Standard deviation of wand length: O desvio padrão (em mm) do comprimento da vareta na 

calibração, preferencialmente inferior a 1-2 mm. 

 

No final da calibração deve-se ter em atenção: 

• Se a calibração preencheu os requisitos ótimos para o início da recolha; 

• O número de marcadores refletores captados por cada câmara; 

Figura 16 - Tabela ilustrativa dos resultados da calibração 
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Figura 18 - Plataformas de força do CEMAH-CIR. Plataforma 1: FP4060-08; Plataformas 2 e 3: FP4060-10 

• Se os marcadores estão a ser captados corretamente; 

• Se as câmaras estiveram conectadas durante toda a calibração. 

1.5 Remoção do sinal de base das plataformas de força Bertec® 

Caso se pretenda realizar uma recolha com as plataformas de força Bertec®, deve-se eliminar o sinal de base 

de ambas as plataformas antes de se iniciar qualquer recolha. Para isso, deve-se pressionar o botão presente 

no amplificador de cada plataforma (Figura 17), devendo aparecer uma luz verde no indicador identificado 

como “Status”. 

Esta ação deve ser realizada sem qualquer carga sobre as plataformas, exceto nos casos em que se pretende 

eliminar a influência de um objeto, como uma cadeira ou um degrau.  

É possível verificar no sistema QTM que os vetores identificados a vermelho, referentes à força de reação 

do solo (FRS) exercida em cada plataforma, irão desaparecer quando cada botão for pressionado. Caso se 

pretenda utilizar apenas uma plataforma, deve selecionar-se Tools > Project options > Force Data e na janela na 

secção Force plates remover a seleção das plataformas que não serão utilizadas. As plataformas encontram-se 

identificadas como representado na Figura 18:  

 

 

  

Figura 17 - Remoção do sinal de base das plataformas de força 
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Antes de iniciar uma recolha formal, deve verificar-se, no modo 3D do sistema QTM, o aparecimento de 

um vetor quando um participante se encontra sobre cada uma das plataformas (Figura 19).  

 

Os valores das plataformas de força estão presentes na janela Force Data (Figura 20). Para aceder a esta janela 

seleciona-se View > Data Info 1, seguido de um clique com o botão direito do rato sobre a janela e da seleção 

de Display Force Data ou através do atalho CTRL+D. Durante esta verificação, recomenda-se confirmar se 

a orientação do vetor corresponde à direção esperada da força, bem como se a sua magnitude é compatível 

com o peso do participante ou de outro objeto. 

O Display Force Data permite a visualização do traçado da força ou da variação dos componentes do centro 

de pressão em tempo real, clicando com o botão direito do rato sobre o parâmetro de interesse. 

1.6 Aquisição de sinal EMG através do sistema Delsys Avanti integrado no sistema de captura de 

imagem optoelectrónico do CEMAH-CIR 

A aquisição de sinal EMG utilizando o sistema Delsys Avanti, integrado no sistema de captação de imagem 

optoelectrónico, é um processo que requer atenção meticulosa aos detalhes técnicos para garantir a precisão 

e a qualidade dos dados obtidos. A seguir, são apresentados os passos essenciais e os materiais necessários 

para a realização dessa aquisição. Para a correta utilização do hardware Delsys Avanti disponível no CEMAH-

CIR, são necessários: 

Figura 19 - Vetores das plataformas de força 

Figura 20 - Dados das plataformas de força 
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• Sensores de EMG Delsys fixos através de adesivos Delsys ou de marca branca (Figura 21); 

• Base Station Delsys (Figura 22) para carregar a bateria dos sensores de EMG e para a sua ativação 

através do software Trigno Control Utility; 

• Software EMGworks Acquisition para a avaliação da qualidade do sinal EMG; 

• Software Trigno Control Utility para controlo da Trigno Base station quando o sinal EMG é 

recolhido com o sistema QTM; 

• Software QTM para a recolha integrada do sinal EMG com variáveis cinemáticas e das plataformas 

de força, além de exportação para formatos compatíveis com outros softwares (Visual3D, MATLAB, 

AcqKnowledge). 

A primeira etapa envolve a avaliação da qualidade do sinal EMG. Para isso devem ser adotados os seguintes 

passos: 

Figura 21 - Colocação de adesivos nos sensores Delsys 

Figura 22 - Base Station Delsys 
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1. Abrir o software Delsys Trigno Control Utility 3.6.0, surgindo uma página com 16 caixas numeradas, 

representando os sensores (Figura 23); 

2. Identificar o ícone na Base Station Delsys para iniciar a sincronização de cada sensor. Passe 

cada sensor sobre o ícone durante, no máximo, 6 segundos, observando a alteração da cor do sensor 

para verde na sua face dorsal e no software. Uma aplicação prolongada do sensor sobre o ativador 

magnético pode levar a que este entre num modo de operação diferente; 

3. Verifique a cor da esfera no software, que deve passar de laranja para verde, indicando a conexão 

bem-sucedida dos sensores; 

4. No caso de se pretender recolher dados das unidades de medição inercial, deve-se selecionar a 

opção nas definições de cada sensor (Figura 24); 

5. Desligar o Delsys Trigno Control Utility 3.6.0; 

6. Abrir o software EMGworks Acquisition; 

Figura 23 - Identificação dos sensores ativos no Delsys Trigno Control Unity 3.6.0 

Figura 24 - Configuração dos settings dos sensores Delsys 
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7. Clicar em Workflow Environment Pro (Data Acquisition) e, em New Project para criar um projeto novo 

(Figura 25);  

8. Após a criação da pasta do projeto, clicar em New para configurar a recolha (Figura 26);  

9. Selecionar e identificar os sensores com os nomes dos músculos a serem avaliados (Figura 27), na 

opção ”Plot and Store”. Selecionar também a opção que permite a avaliação da qualidade do sinal 

(”Signal Preview”). Clicar em Start Test para iniciar a recolha dos dados em repouso e em contração; 

10. Verificar a qualidade do sinal através do Signal Quality Manager, garantindo que o índice da relação 

sinal/ruído, ruído de base e a interferência de sinais/equipamentos elétricos e/ou clipping se 

Figura 25 - Criação de um novo projeto 

Figura 26 - Configuração da recolha 

Figura 27 - Configuração da recolha – parâmetros da tarefa 
Figura 28 - Avaliação da qualidade do sinal EMG 



 21 

encontram dentro dos valores recomendados pelo fabricante. Os valores recomendados serão 

conseguidos se o ponteiro se encontrar sobre à área verde do gráfico (Figura 28). 

Existem vários fatores que podem interferir com a qualidade do sinal EMG incluindo ruído elétrico de 

linhas de energia e fontes externas, artefactos de movimento, crosstalk, clipping e ruído fisiológico. 

A interferência de linhas elétricas (50 Hz), lâmpadas fluorescentes e dispositivos elétricos tem origem na 

radiação eletromagnética que é generalizada em todos os ambientes. Embora isso geralmente não seja uma 

preocupação com a tecnologia moderna, a interferência da linha pode, em alguns casos, contaminar o sinal 

EMG. 

O artefacto de movimento é causado pelo movimento relativo do sensor em relação à pele subjacente sobre 

o músculo de interesse. Pode resultar de: 1) um impacto direto no sensor ou no corpo, 2) um movimento 

rápido do segmento corporal ao qual o sensor está ligado, 3) alterações no equilíbrio químico da interface 

pele-elétrodo devido a mudanças volumétricas durante o encurtamento e alongamento durante a contração 

muscular. O artefacto de movimento é particularmente problemático durante contrações dinâmicas ou 

atividades vigorosas. Para garantir evitar artefactos de movimento, o utilizador deverá garantir uma boa 

fixação do elétrodo à pele. No caso, de ainda assim serem notados artefactos de movimento, a filtragem 

passa-alto do sinal EMG de superfície a 20 Hz poderá ser realizada para reduzir o artefacto de movimento, 

cuja energia é concentrada principalmente em baixas frequências, preservando o conteúdo de frequência do 

sinal EMG do músculo de interesse.  

Algumas porções do sinal EMG podem não ser do músculo de interesse. Em vez disso, podem resultar de 

sinais propagados para o sensor a partir de músculos vizinhos. Estes sinais de crosstalk tornam-se 

sobrepostos ao sinal EMG do músculo de interesse, e a sua presença distorce a amplitude e o tempo dos 

dados EMG. 

O descolamento do sensor ou amplitude excessiva do sinal EMG pode causar saturação, comumente 

referida como clipping. Se isso ocorrer, o contato entre o sensor e a pele deve ser fixado, o ganho do 

amplificador deve ser reduzido, se possível, ou a localização do sensor no músculo deve ser movida para 

reduzir a amplitude do sinal.  

O ruído fisiológico tem origem noutros tecidos, para além dos músculos, que geram sinais elétricos, como 

o sinal eletrocardiograma. Estes podem ser reduzidos localizando corretamente o sensor EMG mais longe 

da fonte do ruído. 

Para garantir uma boa qualidade do sinal EMG o utilizador deverá seguir os procedimentos indicados na 

secção 1.9 Preparação do participante para avaliação cinemática 

Após a verificação da qualidade do sinal, podem ser realizados os procedimentos para aquisição do sinal via 

sistema QTM. Para isso devem ser adotados os seguintes passos: 

• Fechar o software EMGworks Acquisition; 

• Abrir o software Delsys Trigno Control Utility 3.6.0. Os sensores previamente emparelhados deverão 

aparecer a verde (Figura 23); 

• Manter o software Delsys Trigno Control Utility 3.6.0 conectado durante toda a aquisição para 

garantir que o QTM recebe corretamente o sinal EMG. 

 

1.7 Recolha estática necessária para criação do modelo em Visual3D 
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Caso se pretenda recorrer ao software Visual3D para o processamento de dados, e construção do modelo, 

após realizar a calibração, deve-se realizar uma recolha inicial estática, entre 5 e 10 segundos, com o 

participante na posição ortostática (em pé, com os braços ao longo do corpo, ligeiramente afastados e com 

as palmas das mãos viradas para fora) e o mais imóvel possível para garantir a visualização de todos os 

marcadores. A partir desta avaliação, é possível a posterior criação de um modelo de corpo rígido necessário 

para a análise no software Visual3D. Em diferentes laboratórios são realizadas duas avaliações estáticas, que 

servem de garantia para a fase de processamento posterior. Uma recolha estática é válida, quando aparecem 

todos os marcadores a 100% (Qualisys, 2011). 

1.8 Realização e Monitorização de uma Recolha 

Assim que se inicia uma recolha, deve-se confirmar que todos os marcadores estão presentes e que todos 

os sistemas associados estão a recolher dados. Para verificar os marcadores, deve ser selecionada a vista 3D 

e contabilizar todos os marcadores que estão presentes, bem como confirmar a existência do vetor força 

resultante aquando da passagem sobre as plataformas. Para verificar a conexão com o sistema de EMG 

Delsys deverá confirmar o sinal dos sensores Delsys EMG no QTM através da opção View → Data Info 1, 

solicitando o respetivo gráfico para exibir o sinal EMG. Se a variação for a expectável, prossiga com a 

verificação dos outros sensores. 

Após a verificação recomendada, deve-se dar início à recolha. Para isso, selecionar o ícone start, surgindo a 

janela Start Capture (Figura 1). Nesta, deve-se inserir o intervalo de tempo pré-definido para a recolha e 

selecionar a opção de salvar automaticamente após a sua conclusão (Figura 29). A opção Add counter starting 

permite numerar os ficheiros QTM, mudando a sua nomenclatura entre repetições. Nos casos em que a 

recolha tem de ser rejeitada, deve-se retirar um valor à contagem das repetições para que os ficheiros sigam 

uma sequência lógica. Quando os parâmetros estão definidos, deve selecionar-se Start para dar início à 

recolha. Caso se pretenda terminar a recolha antes do tempo pré-definido, deve selecionar-se o quadrado 

preto Stop na barra superior.  

Durante a recolha devem ser visualizados o máximo de janelas para garantir uma boa monitorização da 

tarefa que está a ser realizada. Assim, o QTM permite adicionar várias janelas e organizá-las de forma 

personalizada.  

É aconselhado manter a janela de visualização 3D ativa para visualizar os marcadores, bem como janelas 

com os sensores de EMG. Assim, deve seguir-se o procedimento anteriormente descrito para aceder aos 

canais de EMG e, em seguida, selecionar Window > Title Horizontal ou Title Vertical para organizar as janelas. 

Se o esquema de visualização for adequado às necessidades, pode ser guardado para futuras recolhas através 

de Window > Window Layouts > Save as > Layout 1 ou outro à escolha. Por outro lado, é possível definir o 

layout guardado como predefinido para futuras recolhas, utilizando a opção Default File Layout.  

Assim que terminar a recolha, deve ser realizada uma inspeção de cada um dos dados recolhidos. Uma 

recolha é válida, quando o sinal EMG tem uma variação expectável e quando as plataformas de força 

apresentam valores expectáveis e o vetor força de reação resultante. Por outro lado, uma recolha é 

considerada inválida quando ocorrer a queda de um ou mais marcadores e/ou sensores de EMG, quando o 
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sinal EMG apresentar uma variação que indique o descolamento do sensor sobre a pele, ou quando as 

plataformas de força não registarem valores nem apresentarem o vetor correspondente. 

Nota: Nos ensaios que considerem a tarefa da marcha, o movimento deverá ser realizado no sentido do 

eixo y, de acordo com os eixos de coordenadas do laboratório (Figura 18). 

1.9 Preparação do participante para avaliação cinemática 

A preparação do participante para uma análise cinemática é preponderante e muitas vezes corresponde à 

maior parte do tempo da recolha, sendo recomendada a sua boa execução, visando uma correta 

operacionalização dos procedimentos envolvidos. A preparação inicia-se com a colocação padronizada dos 

marcadores refletores de modo a viabilizar a análise dos dados, bem como torná-los precisos e fiáveis. Para 

garantir uma recolha cinemática bem-sucedida, deve-se assegurar que os marcadores refletores: 

• São colocados corretamente sob as referências anatómicas, de acordo com as referências 

bibliográficas ou com protocolos pré-estabelecidos, não devendo o vestuário interferir com a sua 

posição (Has-motion, 2024; Mesquita et al., 2019; Sousa et al., 2013); 

• São colocados com fita-cola de dupla-face, nos locais previamente assinalados com um marcador 

hipoalergénico, de modo que seja possível recolocar no ponto exato, caso o marcador se desloque 

do local original. No entanto, se um marcador sair da referência anatómica, é recomendada a 

gravação de uma nova recolha estática em posição anatómica, para a criação de um modelo 

anatómico de marcadores atualizado; 

Figura 29 - Iniciar uma recolha 
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• Sejam captados pelas câmaras ao longo de todo o movimento em análise, sendo necessário, em 

determinadas situações, a utilização de marcadores refletores com maior diâmetro, de forma a 

garantir que estas são continuamente captadas pelas câmaras. Esta estratégia deve ser usada apenas 

em situações pontuais, uma vez que pode gerar complicações no processamento de dados por 

outros softwares (por exemplo o Visual3D™). A boa prática de utilização dos marcadores dita que 

estes devem ter todos o mesmo tamanho; 

Em determinados setups de marcadores, podem ser utilizados clusters, estruturas leves e rígidas com 3 ou 4 

marcadores refletores, passiveis de serem colocados em qualquer segmento corporal de interesse. Estes 

clusters são menos suscetíveis à possibilidade de se descolarem com o movimento e restringem menos o 

movimento do que outros marcadores, o que melhora a precisão da recolha de movimento, quando 

comparados com as técnicas tradicionais de colocação de marcadores. Para a sua utilização, estes devem ser 

colocados nas faces ântero-laterais dos respetivos segmentos (coxa, perna, braço e antebraço), utilizando 

bandas elásticas acessórias que permitem o ajuste e impedem o deslizamento do cluster durante a recolha. 

Por fim, é recomendado que, ao longo da preparação, o participante seja instruído e esclarecido acerca da 

tarefa, bem como de todas as características inerentes ao processo de recolha. É importante fornecer apenas 

as instruções estritamente necessárias, uma vez que, quanto mais indicações forem dadas ao participante 

acerca do movimento, mais condicionado será o mesmo, podendo diminuir a veracidade de comportamento 

motor. 

1.10 Preparação do participante e dos sensores para avaliação eletromiográfica 

A relação sinal-ruido é a melhor medida da qualidade do sinal EMG. Indica a relação entre o sinal EMG 

durante a contração muscular versus o sinal elétrico indesejado gravado quando o músculo está em repouso, 

ou seja, o ruído basal. A magnitude do sinal EMG depende principalmente da intensidade de contração, da 

localização e orientação do sensor no músculo de interesse, das características de design do sensor e da 

quantidade de tecido adiposo entre a pele e o músculo. A magnitude do ruído de base depende 

principalmente da tecnologia de recolha e da qualidade da interface pele-elétrodo. Quanto maior a relação 

sinal-ruido, mais confiável é a discriminação dos dados EMG do ruído subjacente de base. 

Figura 30 - Exemplo de setup de marcadores utilizado num estudo de investigação para avaliar o movimento do tronco superior e 
inferior durante a transição de sentado para de pé 
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A localização do sensor no músculo é o fator mais importante para uma boa relação sinal-ruido. A colocação 

pode maximizar o sinal EMG fisiológico e minimizar a interferência de crosstalk dos músculos vizinhos. A 

melhor localização do sensor no músculo é geralmente na linha média do músculo, longe das origens 

tendinosas e das zonas de inervação, com a seta do sensor paralela à direção das fibras musculares (cada 

sensor EMG da Delsys tem uma seta no topo que deve ser alinhada ao longo do comprimento do músculo 

para que os locais de deteção de barra paralela transeccionem as fibras musculares). Na linha média do 

músculo, as fibras têm um diâmetro maior e geralmente produzem sinais EMG de maior amplitude. Em 

contraste, localizar o sensor EMG perto das origens do tendão reduz a amplitude do sinal EMG detetado 

porque, à medida que as fibras musculares se aproximam do tendão, elas tornam-se mais finas e em menor 

número. Fibras de menor diâmetro geram menores potenciais de ação de amplitude. Além disso, nesta 

região o músculo é fisicamente menor, o que dificulta a colocação precisa do sensor e potencia a 

interferência de crosstalk dos músculos adjacentes. Quando possível, as zonas de inervação devem ser 

evitadas, pois nessas áreas a atividade elétrica propaga-se em direções opostas ao longo das fibras musculares 

e pode ser atenuada. As fibras musculares geralmente têm uma organização longitudinal ao músculo. Como 

resultado, a atividade elétrica propaga-se predominantemente ao longo do comprimento do músculo.. 

O ruído basal reflete a estabilidade da interface pele-elétrodo e pode ser avaliado através da aquisição do 

sinal elétrico do músculo relaxado. Embora o ruído basal não possa ser completamente eliminado, pode ser 

reduzido através de uma preparação eficaz da pele, para a redução da sua impedância, e do sensor através 

dos seguintes procedimentos: 

1. Limpar a superfície do sensor e as barras de deteção de prata com uma compressa embebida álcool 

isopropílico para remover resíduos. Deixar o sensor secar ao ar durante alguns segundos; 

2. Depilar a área de deteção com uma lâmina descartável; 

3. Limpar da pele com álcool isopropílico para remover óleos e resíduos superficiais. Deixar a pele 

secar ao ar durante alguns segundos; 

4. Remover a camada superficial de pele morta por abrasão ligeira da pele com gel abrasivo (e.g., 

Nuprep) em situações de pele seca; 

5. Retirar um adesivo e colocar no sensor, tendo o cuidado de alinhar as barras de deteção de prata 

através dos orifícios (Figura 21); 

6. Remover o suporte adesivo da interface; 

7. Colocar o sensor na pele no local preparado. 

A localização adequada do sensor EMG é crítica para detetar sinais EMG de superfície de qualidade. O 

utilizador deve consultar um atlas anatómico para determinar a localização precisa, origem, inserção e função 

do músculo a ser estudado, bem como quaisquer músculos próximos que possam produzir crosstalk. Além 

disso, existem já referências específicas para a colocação dos sensores, em diversos estudos (Hermens et al., 

2000) assim como na plataforma SENIAM (www.seniam.org). Recomenda-se os seguintes procedimentos: 

• Colocar o sensor ao longo da linha média longitudinal do músculo desejado com a seta paralela às 

fibras musculares; 

• NÃO colocar o sensor nas extremidades laterais do músculo. Nesta região, o sensor é suscetível a 

detetar sinais de crosstalk de músculos adjacentes; 

• Colocar o sensor entre um ponto motor (zona de inervação) e a inserção do tendão ou entre dois 

pontos motores; 

• NÃO colocar o sensor sobre ou perto do ponto do motor; 
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• NÃO colocar o sensor sobre ou perto do tendão do músculo. 

No caso de existir ruido da linha elétrica (50Hz) devem ser tidos em consideração os seguintes cuidados: 

• Usar uma compressa embebida em álcool fresco para umedecer novamente o local de aplicação do 

sensor para que fique húmido e reaplicar o sensor EMG; 

• Certificar que não há instrumentação nas proximidades da área de aquisição ou conexão elétrica, 

introduzindo interferência de linha no sinal EMG; 

• Certificar que as linhas elétricas na sala têm uma referência terra. Pode não ser o caso em estruturas 

mais antigas; 

• Realizar a avaliação numa sala o mais eletricamente silenciosa possível. 

O descolamento do sensor ou amplitude excessiva do sinal EMG pode causar saturação, comumente 

referida como clipping. Se ocorrer: 

• O contacto entre o sensor e a pele deve ser assegurado; 

• O ganho do amplificador deve ser reduzido, se possível; 

• A localização do sensor no músculo deve ser alterada para reduzir a amplitude do sinal EMG. 
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II. Procedimentos de análise de dados biomecânicos no 
Laboratório de Análise de Movimento Humano do 

CEMAH-CIR 

2.1 Processamento e análise de dados cinemáticos 

Depois de efetuada uma recolha de dados válida com o sistema optoelectrónico do Laboratório de Análise 

de Movimento do CEMAH-CIR, deve-se proceder ao seu processamento através do software QTM para a 

extração de dados 3D, 6DOF e força, ou para a sua exportação em formatos compatíveis com os programas 

Visual3D™ (.c3d) ou MATLAB (.mat). 

A análise de ficheiros em formato QTM pressupõe um conjunto de procedimentos de processamento dos 

dados em bruto extraídos da recolha cinemática, de forma a permitir a obtenção e compreensão das variáveis 

finais definidas para o estudo. 

2.1.1 Identificação de trajetórias 

De forma a analisar os dados corretamente, é recomendado que que a trajetória dos marcadores tenha o 

respetivo label com 100% da trajetória completa (Nota: diferentes trajetórias podem representar o 

movimento do mesmo marcador, isto é, pode existir casos em que a trajetória “unidentified_01” e 

“unidentified_02”, e cada uma contribuir em 50% para o total da trajetória.). A identificação manual das 

trajetórias é necessária para a criação de um AIM (Automatic Identification of Markers) model. Esta identificação 

pode ser realizada através de 3 métodos: 

• Método de identificação: Na janela 3D, deve ser selecionada a função Identify através do clique 

com o lado direito do rato sobre a trajetória que se pretende identificar. De seguida, deve ser 

selecionada a opção Labeled, surgindo na janela Labeled trajectories a trajetória para ser nomeada 

(Figura 31). Pode também optar-se por selecionar a trajetória a identificar, seguido da tecla L. 

Figura 31 - Identificação dos marcadores refletores 
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Este processo deve ser repetido para todas as trajetórias não identificadas, a fim de criar a Label list que será 

aplicada para as restantes recolhas do estudo. Para guardar a Label list, deve ser selecionado Edit > Labels > 

Save label list (Figura 32).  

A lista pode ser criada também a partir de um ficheiro em bloco de notas e é carregada para o ficheiro QTM 

através de Edit > Labels > Load label list ou clicando com o botão direito do rato na janela Labeled Trajectories 

(Figura 33). 

• Método de identificação rápida: Na janela 3D, após a inserção da Label list, deve ser selecionado 

o botão ID (Quick Identification), presente na barra vertical à esquerda no ecrã (Figura 34). 

Seguidamente, selecionar o primeiro nome das trajetórias na janela Labeled trajectories e selecionar a 

representação digital do marcador correspondente (representado a vermelho). O processo deverá 

ser realizado sucessivamente na ordem disposta na Label list. 

Figura 32 - Gravação da lista de marcadores 

Figura 33 - Introdução da lista de marcadores 
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• Método de identificação de arrastar e soltar: Na janela 3D, após a inserção da Label list, é 

possível arrastar os marcadores não identificados, até ao respetivo nome presente na janela Labeled 

trajectories. Este método também pode ser aplicado entre diferentes janelas, ou seja, é possível 

arrastar trajetórias da janela Unidentified trajectories para a Labeled trajetories. É possível arrastar uma 

trajetória para um identificador que já contenha dados, sendo que as duas partes serão associadas 

se não existir sobreposição; 

Os métodos de identificação devem ser realizados até que se obtenha 100% no Fill level das trajetórias na 

janela Labeled trajectories, o que significa que o marcador está identificado durante toda a recolha. Se após 

estes procedimentos não se atinjam os 100% ou não existam trajetórias por identificar para serem 

adicionadas aos marcadores de interesse, devem ser realizados os procedimentos de preenchimento de falhas 

(ver secção .1.3 Falhas 

2.1.2 Personalização de trajetórias e Bones 

É possível alterar a cor de cada trajetória ou de um grupo de trajetórias, selecionando o(s) Label(s) das 

trajetória(s), clicando com o lado direito e selecionando Change Trajectory Color. Esta formatação pode ser 

salva no AIM Model.  

De forma a estabelecer a ligação entre dois marcadores, devem ser selecionados os marcadores na janela de 

visualização 3D, clicando com o lado direito e selecionando Bone > Create bone . É possível criar esta ligação 

a partir do botão Create bones sequence na barra lateral (Figura 35) e alterar a sua cor através da seleção do(s) 

Bone(s), clicar com o lado direito do rato e selecionar Change Bone Color. Os Bones facilitam a visualização do 

padrão de movimento dos marcadores e segmentos. 

2.1.3 Falhas 

As trajetórias podem apresentar falhas de dois tipos: falhas por falta de medição ou falhas por falta de 

identificação. O primeiro tipo implica que a trajetória seja completada manualmente. Estas estão 

identificadas a cor castanha no gráfico (Figura 36). As falhas por falta de identificação podem ser alteradas 

manualmente ou através da melhoria do modelo através do Trajetory Editor presente no menu View da barra 

de ferramentas (atalho Ctrl + T) ou no painel da barra de ferramentas superior (Figura 4).  

Figura 34 - Método de identificação rápida 
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As falhas na trajetória podem ser completadas através de 5 tipos diferentes de preenchimento do Trajectoy 

Editor, disponíveis ao selecionar o botão  (Figura 36): 

• Estático - As falhas são preenchidas com valores fixos para X, Y e Z, conforme especificado. Este 

tipo de preenchimento é tipicamente aplicado a marcadores estáticos, que representem objetos que 

não se movem durante a recolha (e.g., mesa ou degrau); 

• Linear - As falhas são preenchidas por uma interpolação linear entre os respetivos limites da 

trajetória. Se o intervalo estiver no início ou no final de uma captura, o intervalo será preenchido 

com um valor constante (o primeiro valor depois da falha ou o último valor antes da falha, 

respetivamente). Opções: 

o Comprimento máximo: É possível aplicar um comprimento máximo para o 

preenchimento de falha linear; 

o Número de frames: É possível especificar o número máximo de frames para preenchimento 

da falha com trajetória linear. 

• Polinomial - As falhas são preenchidas por uma interpolação polinomial cúbica entre os respetivos 

limites da trajetória. O preenchimento de falhas polinomiais exige que os limites anteriores e 

posteriores à falha tenham um comprimento de pelo menos dois frames. Opções: 

o Comprimento máximo: É possível aplicar um comprimento máximo para o 

preenchimento de falha linear; 

Figura 35 - Representação do processo de criação de Bones 

Figura 36 - Janela Trajectory Editor 
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o Número de frames: É possível especificar o número máximo de frames para preenchimento 

da falha com trajetória polinomial. 

• Relacional - As falhas são preenchidas com base no movimento dos marcadores circundantes. São 

escolhidos um, dois ou três marcadores de contexto, que são usados para definir um sistema de 

coordenadas local (LCS). A trajetória preenchida consiste numa interpolação linear no LCS, que é 

então transformada para o sistema de coordenadas global. Se a falha estiver no início ou no final 

de uma captura, a parte preenchida será extrapolada. Pode-se arrastar e soltar trajetórias no campo, 

se a trajetória estiver bloqueada (Figura 37). Especificações: 

o Origem (obrigatório): Marcador que define a origem do LCS, preferencialmente um 

marcador próximo ao marcador com trajetória a preencher. Se apenas for definida a 

Origem, a trajetória preenchida será inteiramente translacional; 

o Eixo X: Marcador que define o eixo primário do LCS. De preferência, o movimento do 

eixo primário deve estar fortemente correlacionado com o do marcador da trajetória a 

preencher. Se o marcador de destino estiver na mesma linha que os marcadores Origem e 

Eixo X, deve ser suficiente especificar apenas esses dois marcadores de contexto; 

o Plano XY: Marcador que define o eixo secundário do LCS, fixando a orientação completa 

do marcador a identificar; 

o Corpo rígido: Esta opção deve ser selecionada caso os três marcadores definidos 

anteriormente pertençam a uma estrutura rígida. Assim a posição do LCS será calculada 

através de um ajuste ao corpo rígido.  

• Virtual - Tal como no preenchimento Relacional, as falhas são preenchidas com base no 

movimento dos marcadores circundantes. No entanto a parte preenchida é independente dos dados 

da trajetória circundante. São especificados um, dois ou três marcadores de contexto, que são 

usados para definir um LCS. A trajetória preenchida representa o movimento da origem do LCS, 

com um deslocamento opcional que pode ser especificado em: 

Figura 37 - Preenchimento de trajetórios através do método Relacional 
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o Origem (obrigatório): Marcador que define a origem do LCS, preferencialmente um 

marcador próximo ao marcador com trajetória a preencher. Se apenas for definida a 

Origem, a trajetória preenchida será inteiramente translacional; 

o Eixo X: Marcador que define o eixo primário do LCS. De preferência, o movimento do 

eixo primário deve estar fortemente correlacionado com o do marcador da trajetória a 

preencher. Se o marcador de destino estiver na mesma linha que os marcadores Origem e 

Eixo X, deve ser suficiente especificar apenas esses dois marcadores de contexto; 

o Plano XY: Marcador que define o eixo secundário do LCS, fixando a orientação completa 

do marcador a identificar; 

o Corpo rígido: Esta opção deve ser selecionada se os três marcadores definidos 

anteriormente pertençam a uma estrutura rígida. Assim, a posição do LCS será calculada 

através de um ajuste ao corpo rígido; 

o Deslocamento: É possível aplicar um deslocamento ao ponto virtual, relativo à origem do 

LCS (X, Y, Z: valores de deslocamento de X, Y e Z em mm ou percentagem); 

o Deslocamento relativo (%): Especificar o deslocamento em percentagem em relação à 

distância entre os marcadores de origem e o eixo X. 

Em suma, para o preenchimento de falhas que possam surgir na trajetória dos marcadores, deve ser 

selecionada a falha e aplicar o tipo de preenchimento que mais se adequa, finalizando ao premir o botão Fill       

ou a tecla F. 

Nota: Caso se pretenda aplicar o mesmo tipo de preenchimento a todas as falhas da trajetória, é possível 

selecionar toda a trajetória (Ctrl+A) e parâmetros, como descrito anteriormente. 

2.1.4 Spikes and Smoothing  

Os picos ou spikes (Figura 38) são alterações súbitas e pronunciadas nas trajetórias, que podem ocorrer 

devido à ocultação de marcadores numa ou mais câmaras, ou a erros de identificação causados pela troca 

com marcadores adjacentes, sobretudo em locais onde a aceleração ultrapassa um threshold de 150 m/s2 

(Sousa et al., 2021). 
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A correção destas alterações pode ser feita através do Smoothing ao selecionar a janela temporal de interesse 

no Trajectory editor, seguido do botão Smooth  (Figura 39). 

Desta forma, podem ser definidos diferentes tipos de smoothing, nomeadamente: 

• Média Móvel (Moving Average): Suavização por meio de uma média móvel não ponderada dentro 

de uma janela centralizada definida pelo utilizador. Este método é adequado para suavizar picos 

locais de curta duração (marcados a vermelho no indicador do tempo), uma vez que não permite a 

diferenciação entre frequência fisiológica e artefacto; 

• Butterworth: através de um fourth order Butterworth low-pass filter (para a sua aplicação devem estar 

selecionados um mínimo de 7 frames). O filtro Butterworth permite atenuar momentos em que a 

trajetória tem uma frequência superior à frequência de corte, possibilitando a separação entre 

movimentos com frequências fisiológicas (mais baixas) e artefactos (mais altas). É adequado para a 

redução do ruído de alta frequência em grandes intervalos de tempo: 

o Cutoff: A frequência de corte deve ser definida de acordo com o protocolo, os objetivos e 

o processamento de dados definidos para o estudo. 

Nos casos em que o smoothing é insuficiente devido a picos de elevada amplitude ou perturbações acentuadas 

nas trajetórias (rugosidade semelhante a um planalto), é recomendada a sua eliminação e posterior 

preenchimento dos dados em falta através dos métodos referidos anteriormente. 

Figura 38 - Exemplos de picos e planaltos nas trajetórias dos marcadores 

Figura 39 - Trajectory Editor: Smooth 
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2.1.5 Adicionar trajetórias virtuais 

Para adicionar novas trajetórias devem ser selecionadas múltiplas trajetórias na janela 3D ou Trajectory Info. 

Posteriormente, deve ser selecionado Add new trajectory > Virtual (Average of selected trajectories) ou criar a 

trajetória virtual no Trajectory Editor após inserir uma nova trajetória vazia no Trajectory Info. No Trajectory 

Editor deve ser selecionado o preenchimento com Constant ou Virtual: 

• Constant - cria uma trajetória virtual estática ao especificar as coordenadas X, Y e Z; 

• Virtual - processo descrito para o preenchimento de falhas do tipo virtual. 

2.1.6 Criação do AIM (Automatic Identification of Markers) Model 

O AIM model é criado a partir de ficheiros .qtm com os marcadores já identificados e tem como função a 

identificação automática dos marcadores. Este modelo pode ser aplicado a qualquer ficheiro que utilize o 

mesmo setup de marcadores com a realização de tarefas semelhantes. 

Para criar um AIM model, deve ser criado um ficheiro com todas as trajetórias identificadas. O ficheiro 

utilizado deverá ser um ficheiro com movimento e não um ficheiro estático. 

Quando o ficheiro estiver com todas as trajetórias identificadas, deve ser seguido o conjunto de comandos: 

AIM > Generate > Model > Create new model > Verify (Figura 40). 

Nesta fase, será importante verificar se todos os marcadores estão presentes no modelo e, se os bones criados 

automaticamente pelo modelo (criados entre os marcadores que apresentam menor movimento entre si), 

ligam corretamente os marcadores. Pode ser utilizada a ferramenta Delete bone para eliminar as ligações 

Figura 40 - Generate AIM model 

Figura 41 - Criação do AIM model 
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incorretas, e o AIM model procurará uma nova solução para a ligação entre os marcadores. O processo deverá 

ser repetido até todas as ligações estarem corretas (Figura 41). 

O modelo pode depois ser aplicado a outros ficheiros com captura de movimentos semelhantes. Para esse 

processo, devem ser utilizados os seguintes comandos: AIM > Apply model. Na janela Applied Model colocar 

o modelo a aplicar. 

Em recolhas que avaliem simultaneamente mais que um indivíduo, é possível atribuir diferentes modelos 

para cada um deles. Para a aplicação de AIM models em múltiplos indivíduos na mesma medição, sugere-se 

que se consulte o manual QTM, uma vez que este não é um procedimento habitual realizado no CIR 

(Qualisys, 2011). 

No final da identificação dos marcadores em novas recolhas, é possível adicionar essa identificação a um 

AIM model previamente criado, através da opção Add to existing model (Figura 40). Esta função permite 

melhorar progressivamente a capacidade de identificação automática do modelo.  

2.1.7 Análise de Dados  

Através do software QTM é possível extrair dados relativamente à posição, velocidade e aceleração dos 

marcadores, distância, distância percorrida, ângulos, velocidade angular e aceleração angular. Desta forma, 

devem ser selecionadas os marcadores para a análise, com recurso ao rato e a tecla CTRL (Nota: em relação 

aos ângulos, devem ser selecionados 3 marcadores que constituem o braço rígido, o braço fixo e o fulcro 

ou 4 marcadores, quando não existe um fulcro comum). Após a seleção dos marcadores, deve-se clicar no 

botão direito do rato, seguido de Analyze (Figura 42). 

Ao surgir a nova janela, é possível selecionar Use Filter, antes e após o cálculo. Existem dois filtros: 

• Fit to 2nd degree curve - Identifica a curva de segundo grau que melhor se adequa para cada frame, 

e posteriormente adapta o valor da curva ao frame em análise; 

• Moving Average – Identifica um valor médio para cada frame; 

A aplicação de filtros para melhorar a análise das trajetórias dos marcadores deve ser cuidadosamente 

ponderada, uma vez que o uso excessivo pode comprometer a qualidade dos dados. Assim, deve selecionar-

se o método mais adequado à análise pretendida, quer seja através da aplicação de um filtro diretamente 

sobre a trajetória ou através da filtragem durante o cálculo das variáveis cinemáticas. 

Figura 42 - Representação do processamento de marcadores 
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No parâmetro Frames in filter window, por defeito, é utilizado o valor pré-definido (Figura 43). No entanto, 

recomenda-se a pesquisa de um valor específico mediante o tipo de estudo a realizar. O número de frames 

deve ser um valor ímpar e quanto maior a janela, menor a sensibilidade para os valores pico. Posteriormente, 

deve ser selecionada uma variável para análise: 

• Posição - Indica a posição dos marcadores ao longo do tempo, tendo em conta o referencial global; 

• Velocidade - Calcula a velocidade das trajetórias. Ao selecionar magnitude, é permitido o cálculo da 

rapidez; 

• Aceleração - Calcula a aceleração; 

• Distância - Calcula a distância entre duas trajetórias ao longo do tempo; 

• Distância percorrida - Calcula a distância que a trajetória percorreu. A distância aumentará por 

cada frame em que a marca se mova mais de 0.2 mm. Deve ser considerada a importância da 

aplicação de filtros, uma vez que esta medida é influenciada pelo ruído presente na recolha; 

• Ângulo - Calcula o ângulo entre dois segmentos de reta, definidos por 3 ou 4 marcadores. Os 

resultados são projetados num plano (Components) ou no seu valor resultante (Magnitude) (Figura 42); 

• Velocidade angular - Calcula a velocidade para um ângulo determinado, em º/segundo. 

Corresponde à primeira derivada do ângulo; 

• Aceleração angular - Calcula a aceleração para um ângulo determinado. Corresponde à segunda 

derivada do ângulo. 

Nota: para cada medida é possível determinar a magnitude ou components: 

• Para posição, velocidade, aceleração e distância - components corresponde aos valores reais nos três 

eixos do referencial global. Por outro lado, magnitude corresponde à soma vetorial dos três 

componentes (intensidade do vetor). Assim, magnitude assume diferentes significados consoante a 

variável analisada:  

o Posição - distância entre a origem e a trajetória, em mm; 

o Velocidade - rapidez das trajetórias, em mm/s; 

o Aceleração - magnitude de aceleração, em mm/s2; 

o Distância - distância entre duas trajetórias, em mm. 

• Para ângulo e velocidade angular - components corresponde à projeção do ângulo em cada plano do 

referencial global, enquanto magnitude representa o ângulo entre dois segmentos. 
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Por fim, estes dados podem ser exportados em TSV (no canto inferior esquerdo da janela) (Figura 43). 

2.1.8 Adição de Eventos 

Os eventos podem ser adicionados durante a recolha de dados ou posteriormente. Durante a recolha, pode 

ser utilizado um Trigger Event, que gera um evento previamente definido. Contudo, é possível adicionar 

manualmente um evento após a recolha de movimento, através do botão Add Event (Ctrl+E) (Figura 44). 

Figura 43 - Representação dos métodos para extração de variáveis 

Figura 44 - Método para adição de eventos 
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Os eventos são visualizados na timeline com um triângulo. Nos gráficos, são definidos por uma linha 

vermelha. Ao passar com o rato sobre o evento é possível clicar com o lado direito e escolher a opção Edit 

Event List (Figura 45) onde podem ser editados a identificação, o tempo ou o frame de cada evento. 

Os eventos podem ser exportados para outros programas. Na exportação em formato C3D, os eventos são 

sempre incluídos automaticamente. Para ficheiros em formato TSV, é necessário ativar a opção Include Events 

no momento da exportação, e para ficheiros MATLAB, deve ser ativada a opção Events. 

2.2 Visualização de Dados Cinéticos 

A força é calculada a partir dos dados analógicos das plataformas de forças. Os dados das forças podem ser 

visualizados na janela Data Info ou em forma de vetor com base no centro de pressão na janela de visualização 

3D. O vetor observado representa a força oposta à que é aplicada sobre a plataforma, ou seja, a força de 

reação. É possível exportar o documento com os valores em File > Export > To selecionando o formato de 

ficheiro que pretende (Figura 46). 

  

Figura 45 - Método para edição de eventos 

Figura 46 – Formatos de ficheiros de exportação 
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2.3 Exportação dos dados para outras aplicações 

Os ficheiros em formato .qtm podem ser exportados para outros formatos, permitindo a sua utilização em 

diferentes aplicações. É possível exportar para os formatos TSV (Figura 47), C3D (Figura 48), MATLAB 

(Figura 49) e AVI (Figura 50). 

Ao exportar os dados em TSV, podem ser gerados vários ficheiros, consoante o tipo de dados recolhido. 

Cada ficheiro é identificado com um sufixo, como por exemplo:  

• _a: dados analógicos (sinal de EMG, dados em bruto das plataformas de força, entre outros); 

• _f1, _f2, _f3: dados das plataformas de força 1, 2 e 3, respetivamente; 

• _2D: dados bidimensionais das câmaras; 

Figura 47 - Janela de visualização para exportação de dados em formato TSV 
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• _3D: dados tridimensionais de corpos rígidos, caso existam. 

 

Figura 48 - Janela de visualização para exportação de dados em formato C3D 

Figura 49 - Janela de visualização para exportação de dados em formato MATLAB 
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Figura 50 - Janela de visualização para exportação de dados em formato AVI 
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III. Considerações finais 

A informação presente neste manual constitui uma base introdutória para auxiliar o investigador iniciante 

na utilização do sistema optoelectrónico do Laboratório de Análise de Movimento do CEMAH-CIR. A 

informação apresentada tem como base a experiência do grupo de investigação na utilização deste tipo de 

tecnologia para identificação dos determinantes biomecânicos para a (dis)função do sistema de movimento 

humano em diferentes condições de saúde, nomeadamente acidente vascular cerebral (Couto, Vaz, Pinho, 

Félix, Moreira, Pinho, Mesquita, Mesquita Montes, et al., 2023; Couto, Vaz, Pinho, Félix, Moreira, Pinho, 

Mesquita, Montes, et al., 2023; Couto et al., 2022; Pinho et al., 2025; Pinho et al., 2023; Ribeiro et al., 2021; 

Silva et al., 2013; Silva, Sousa, Pinheiro, et al., 2012; Silva et al., 2015; Silva, Sousa, Tavares, et al., 2012; Silva 

et al., 2014; A. S. Sousa et al., 2015; A. S. P. Sousa et al., 2021; A. S. P. Sousa et al., 2022; Andreia S. P. Sousa 

et al., 2022; A. S. P. Sousa et al., 2015; A. S. P. Sousa et al., 2013; Sousa & Tavares, 2015), doença de 

Parkinson (Fernandes et al., 2015; Fernandes et al., 2016, 2017; Ribeiro et al., 2021), adultos saudáveis 

(Guedes et al., 2025; Sousa & Tavares, 2014; Sousa et al., 2016; Andreia S. P. Sousa, Rui Macedo, et al., 

2013; Sousa et al., 2014; Andreia S. P. Sousa, Augusta Silva, et al., 2013), adultos mais velhos (Castro et al., 

2025; Moreira et al., 2025; Teles et al., 2025), instabilidade crónica do tornozelo (Silva et al., 2019; Silva et 

al., 2017; Sousa, 2018; A. S. P. Sousa et al., 2018; Andreia S. P. Sousa et al., 2018) ou dor no ombro (Lopes 

et al., 2023; Melo et al., 2024; Melo et al., 2025; Pereira et al., 2023). Adicionalmente, para elaboração deste 

manual contamos ainda com a experiência no processo de iniciação científica de estudantes de licenciatura 

e na supervisão e apoio a projetos de investigação integrados em programas de formação avançada incluindo 

projetos de investigação académicos de mestrado e doutoramento na área da reabilitação. 

O desenvolvimento tecnológico na área da biomecânica clínica, favorecendo a personalização dos cuidados 

de saúde em reabilitação e a evolução no sentido do desenvolvimento de métodos rápidos, totalmente 

automáticos, não invasivos, repetíveis e menos dependentes do erro humano evidenciam a necessidade de 

identificar determinantes biomecânicos da (dis)função e da (in)capacidade. Esta necessidade justifica o 

crescente interesse neste tipo de tecnologia para identificação dos determinantes biomecânicos em 

diferentes condições de saúde, mas também na validação de ferramentas clínicas que possam ser utilizadas 

pelos profissionais de saúde no processo de raciocínio clínico e tomada de decisão. 
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